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4 ClickBook Help File

ClickBook is so easy to use. Just choose File / Print from any program and choose the "ClickBook
Printer” when printing.

1.1 What Does ClickBook Do?

ClickBook prints files, documents, graphics, spreadsheets, or web pages from any Windows application:

¢ As Double or Single sided.

e As Books of any size.

¢ As brochures or leaflets.

e As greeting cards.

¢ As CD Jewel Cases.

e As Day Planners.

¢ As business cards.

e As Avery Labels.

e As Banners of any size (Windows Vista, XP, 2000, 2003 only)
o As Posters of any size (Windows Vista, XP, 2000, 2003 only)
¢ As PDF files

Top Uses for ClickBook:
¢ Print double-sided without a duplexing printer.
¢ Print organization charts or schedules on large posters.
o Fit a large spreadsheet on one page with several pages on each sheet of paper.
o Combine documents, web pages, and other files into a single print job.
e Print an address book to fit in your day planner, purse, wallet, etc.
e Create a list of songs and artists and print a booklet that will fit in a CD Jewel Case.
o Design Greeting Cards or print electronic greeting cards received.
¢ Print goals, and objectives in large formats for posting on the walls
e Gather a collection of recipes and print them as a wallet booklet.
e Sales & Marketing Managers use ClickBook to print media, product information, press kits, news, etc.
o Posters for Schedules, Plans, Birthday, Calendars, Pictures, Charity Events, Bulletin Boards, Advertisements (Windows
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Getting Started 5

XP, 2000, 2003, Vista only)
o Educators print handouts, assignments, lessons, ebooks, posters, etc.
e Combine your documents into one convenient PDF file.

About printing books

Printing books requires a special arrangement of the pages. ClickBook takes care of this, giving you instructions each step of
the way so that the back sides are printed correctly relative to the front sides, and so that after you cut and assemble the book,
the pages come out in the right order.

ClickBook has over 170 layouts to choose from, and you can create your own so the variety is endless. The layouts that
come with ClickBook enable you to print:

Sizes from poster size down to credit card size.

Suited for folding and stapling or for cutting and binding by any method.

Two "binding orientations": for binding in the left margin (and turning pages in the standard way) or in the top margin (and
flipping pages up).

Pages of book oriented either as portrait or as landscape.

1.2 How Does ClickBook Work?

- Page Setup,.. —
ok e
q & Frint Preyiew :y* =
¥ 1R
LYY .

ClickBook takes what you print from your application — exactly what would print if you were not using ClickBook — and shrinks
and rearranges the pages to fit the layout you choose.

ClickBook does not change any formatting done by the application program. Each page is preserved exactly as the
application sent it, including margins, page numbering, headers/footers, and all paragraph formatting — everything.

ClickBook formats your document in some or all of the following ways, depending on the printout layout you select and any
modifications you may make to it:

e Shrinking to fit several pages on one sheet of paper.

e Expanding it to "poster" sized and printing it on multiple pages. (Windows XP, 2000, 2003, Vista only)
e Arranging the mini-pages so that they come out in numerical order after cutting and assembling.

¢ Printing double sided.

¢ Adding ClickBook margins.

¢ Adding extra space for binding.

¢ Adding Headers, Footers or Watermarks.

1.3 What's New In ClickBook 12.07?

Look at all of the great features we have added to ClickBook 12.0.

NEW 64-Bit Operating System Compatibility- ClickBook

New Keyboard Shortcuts - Allows you to easily toggle between element of the main ClickBook window.
Image Removal - Saves ink by removing images from your print job. Works well when printing Web Pages.
Updated Interface - New Icons for new Vista like appearance.

NEW Zine Layout - Popular 1 sided booklet layout

© 2009 Blue Squirrel



6 ClickBook Help File

New PDF Catergory- Portrait and Landscape layouts available for faster PDF printing.

Improved Setup - PDF Auto Installs, renamed 'QuickBook to InstantBook, Digitally Signed Install

Updated Borders - Fixed previous bug and allows borders to line up properly on mini pages.

Updated PDF Converter - Saves files without application name infront of file name and fixes Quicken PDF issue .
Reverse Printing - For printing Hebrew style booklets, that open from 'Right to Left'

Digitally Signed Macros - New Digitally signed macros for MS Word, allowing you to print to ClickBook with 'One Click’

ClickBook Suggestions and Feature Requests

We here at Blue Squirrel are dedicated to providing you very useful software and delivering high quality support and customer
service.

We would love to hear from you with any feature request or product improvements that you would like to see in future versions
of ClickBook.

If you have any suggestions, product improvements, and/or feature requests please email us at: sales@bluesquirrel.com
We will add your suggestion and/or feature request to our 'Future Feature' list.

1.4  Printing With ClickBook

The ClickBook printing process typically begins in your application program. You prepare your document as usual, and then
you give the print command. Set options as you wish in the print dialog box, choose the ClickBook Printer, and click OK.
This launches ClickBook where you'll select a layout, optionally change other settings, and hit ClickBook's Print button to send
the print job to the printer.

ClickBook gives you instructions at each step of the way, including how to re-insert the paper to print the second sides.

Following the instructions ensures that the backsides are printed correctly relative to the front sides, and that after you cut and
assemble the booklet, the pages are in the right order.

1.5 Printing Your First Booklet

To Print your first ClickBook Booklet follow these steps.

1. Open the document in its application program.

2. Print the document to the ClickBook Printer (Usually File->Print)

3. When ClickBook pops up, select a layout.

4. Click ClickBook's Print button. (Skip to step 8 now if you're using a duplexing printer.)

5.  When the first-side print job is completely finished, remove the printout stack carefully. Treat the sheets as though they're
glued together — do not rearrange them.

6. Without lifting it off the stack, read the instruction sheet (with the big arrow). It tells you whether to put the paper in face
up or face down, and which end of the paper goes in first. Following the instructions, reinsert the printout stack into the
paper tray.

7. In ClickBook, click the Print Second Side button.

8. When the second-side print job is completed, retrieve the printout and remove the instruction sheet.

9. Assemble the booklet, according to its layout.

1.6 Preparing A Document In Its Application Program

Prepare your document as you usually do, but keep in mind that ClickBook will usually shrink the pages. (ClickBook will scale
them down unless the layout is full-sized or uses the No scaling setting.)

If you plan to use a layout that shrinks the pages considerably, enlarge your fonts accordingly. They should be large enough
to be readable at the mini-page size. Normally, no other special preparation is needed for printing with ClickBook. But in
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Getting Started 7

some cases you may want to adjust the document in the following ways:

1.7

Use a different font that may scale better. We recommend True Type fonts, which are fully scalable.

When printing a multi-document booklet, modify or add headers/footers that are appropriate for the booklet. In particular,
you may want to adjust page numbering to be continuous throughout the whole booklet. See... Headers/footers for a
multi-document booklet.

Turn off right justification of text if the right edge came out uneven on the printout.

Adjust the margins (or set margins in ClickBook).

Select No scaling and then set everything at exactly the size you want it to print. This includes setting fonts at desired
sizes, and setting the page size to be equal to the mini-page size in the intended ClickBook layout ClickBook usually
assures that the pages fit the mini-pages, but with scaling off, this is your responsibility.

Saving A Booklet As a File

To save a print job as a .cb file just follow these steps:

1. Press the Save button

»

3% | on the tool bar.

Or,
Click File on the menu options then click on Save or Save As.

The Save As dialog appears. From the Save in: drop down menu choose the location on your computer where you want
to store the .cbx file.

In the File name: field type in the name you wish to call the .cbx file.

Press Save. Note: before saving, make sure you've deleted or undeleted documents as desired. Any documents marked
as deleted when you save will not be included in the ClickBook .cbx file. Tip: If you want to print similar booklets
containing different subsets of a group of documents, save the whole group as a .cbx file. Then, whenever you want to
print, open the file and temporarily delete undesired documents.

Note: The .cbx file contains the contents of the documents, not just the file names. So, if you edit any of the documents after
saving the .cbx file, these changes are not reflected in the .cbx file.

2.1

Run The Setup Program

The installation setup program for Windows is called ClickBook12Setup.exe. You must run the setup program to install
ClickBook to your hard disk. So that you know what to expect, here's a summary of what the setup program does:

Copies the ClickBook System files to your hard disk.

Creates a ClickBook program group and icons.

Once it's finished installing ClickBook launches the Add Printer dialog where you'll setup a ClickBook Printer on your
system. Then ClickBook's Printer Setup dialog box will open and you will set up the printer(s) you want to use with
ClickBook. You can choose from the Easy Printer Setup Wizard or the Custom Printer Setup Wizard. If you select the
Easy Printer Setup Wizard, and ClickBook tells you that it does not recognize your printer you need to run Custom Printer
Setup Wizard. See "Setting Up an Unrecognized Printer", on the adjacent page.

At the end of the installation process ClickBook presents you with the option to view the README.RTF. We recommend
looking this document over because it contains more information about ClickBook, and the changes that have taken place
from previous versions. ClickBook's online help file provides you with detailed instructions to print the README.RTF as a
booklet.

When you first start the ClickBook program the InstantX registration dialog box will appear. To fully register your copy of

© 2009 Blue Squirrel



8 ClickBook Help File

ClickBook please fill out the form, and send it electronically, or print the form and mail it back to Blue Squirrel. If you don't
register ClickBook the InstantX dialog box will pop up each time you run the program. Once you have registered, you'll
see your License Key code in the About ClickBook box.

Places a customized Print Using ClickBook command into a menu of your application program. This feature is available for

several leading application programs.

To Run the Setup Program:

1. Ifyou have ClickBook on a CD insert the CD into an appropriate drive. Or if your copy of ClickBook is a zipped (*.ZIP) or
self-extracting executable (*.EXE) file, copy it into an empty folder. Double-click or use a zip manager to expand the file.
You can obtain a copy of the self-extracting executable from our Web site,
http://www.bluesquirrel.com/download/ClickBook12Setup.exe..

2. If you have the Blue Squirrel Sampler CD, its AutoStart function will load the CD and present you with an opening screen.
To start the installation process, click on the picture of the ClickBook box.

3. Ifyou have the ClickBook program in another format, click the Windows Start button, choose Settings, and the Control
Panel. Double-click Add/Remove Programs. On the Install/Uninstall page, choose Install, and then Next. Use the
Browse button to navigate to the folder into which you copied or expanded your ClickBook files and click Finish.

4. Follow the prompts on the next screens of the Install Wizard.

When the Setup program is completed, you will need to setup a ClickBook Printer, setup your printer(s), enter registration
information, and then you're ready to print with ClickBook.

System Requirements

Pentium 100 or faster machine
64+ MB of RAM

14 MB of free disk space
Laser or InkJet printer

2.2  Automatic Printer Setup

First you will setup a single "ClickBook Printer" on your system, and then you'll be required to setup your printer(s) in the
ClickBook software.

To automatically detect and install the ClickBook Printer follow these steps:

1. When you are finished installing ClickBook, the Add Printer dialog will add a "ClickBook Printer" to your system. If this
dialog does not appear go to your Windows Start button, select Programs, Blue Squirrel and ClickBook. If this is the first
time you are opening ClickBook you will need to fill in your registration information, close the Tip of the day dialog and the
Add Printer dialog will appear.

2. Inthe Add Printer dialog press OK.

3. The Add Driver dialog will appear, press OK. Now you have setup a "ClickBook Printer", which will appear in most of your
application programs on your computer.

Now you will need to setup your printer(s) in the ClickBook software. Go to Easy Printer Setup to do this.

2.3  Printer Setup

Every printer that you use with ClickBook must be set up. This tells ClickBook how your printer handles paper. This is
necessary to do double-sided print jobs, and so ClickBook can print in the right order.

If you see the E] (icon) next to your printer it means the printer has already been set up with ClickBook.

There are three ways to set up a printer:

© 2009 Blue Squirrel
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Easy Printer Setup - This option tries to determine your printer type from the name and match it against a database of
printers that ClickBook is aware of. In many cases the correct choice will be highlighted and you just hit OK. If you can't
find an exact match, then you can usually choose a printer from the same "family." For example, an HP 1115 would be the
same as an HP 1100 printer. If your printer is not listed, it does NOT mean that ClickBook won't work with your printer, it
simply means you'll need to use the Custom Printer Setup to set up your printer.

Custom Printer Setup - This option takes you through a step-by-step process where you print some pages, re-insert the
paper and then identify the images. Using the information that you provide the program sets up your printer for use with
ClickBook.

Manual Printer Setup - This option lets you answer some questions to provide information to ClickBook about your printer
and how it handles paper. There is also a button that will take you to a website where other ClickBook users have provided
the configuration that worked for their printer.

Remove - Allows you to remove any printers that have been setup for use with ClickBook. When you select the printer and
click remove, the 'Setup' button changes to 'Remove'.

NOTE: Removing the printer from the ClickBook setup only removes it from ClickBook not from your computer.

Properties... - Set the unique properties of each printer. Does it duplex (print on both sides automatically)?

Easy Printer Setup

Once you have installed a ClickBook Printer you will be required to setup your printer(s) in the ClickBook software. Note: You
don't need another driver. A Windows printer driver for the printer, and ClickBook, are all you need.

Follow these steps to use ClickBook's Easy Printer Setup:

Sl

Easy Printer, Setup E]

Frinter being zetup Haz the zame paper path as :

“WighHP Lazerlet BM HF Lazerlet 5

HP Laser)et £/ /404 PostScript | HOWTOPRINT ABOOKLET

HF Lazerlet &

HF Lazerlet 5/5M - Enhanced Open an application and select the Print
HF Lazer)et 580 - Enhanced dialog, usually found o the File menu.
HF Laser)et 550 - Standard Sgt the active printer to the "ClickB ook
HPF Laserlet 5/5M PostSeript Frinter” and press OF.

HF Lazerlet 550 PostSonpt 1.6 Note t . f ClickBook:
HF Laser)et 5000 5eniez PCL 6 I:Il'j (= o) (Al s O LIRS,
HP Laserlat 5L ickEock now uses ane, and only ane
HP LaserJet 5L (Front Output slot) ClickBaak, printer. *When the I:_Iln:kEh:n:nk
HF LaserJet 5L [PCL) program appearz, chooze a printer fram

HF Lazerlet 5L (PCL Front Dutout s the drop-down ||s_t lozated in I:Il_ckB ook,
and prezs the Print button ko print a

HP | aseelat FRAP v booklet

My printer iz not lizted | Cancel

First, make sure that the printer is installed in your Windows system.

Open ClickBook Printer Setup, which is found in the File menu, or click the Windows Start button, go to Programs, Blue
Squirrel, and click on ClickBook Printer Setup.

Choose your printer model from the Printer to Set Up drop down list.

Click Easy Printer Setup.

Make sure the correct printer is highlighted, and click OK. If your printer is not on the list, click Cancel. Then run
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10 ClickBook Help File

Custom Printer Setup.

6. Depending on your printer model, ClickBook may present you with another screen asking you if your printer can duplex.
Answer Yes, if your printer prints double-sided without user intervention. Answer No, if your printer only prints single-
sided.

7. Please repeat steps 1 through 6 to setup a second, third or fourth printer.

Note: For most programs, you can substitute one printer model for another similar one. However, because ClickBook prints
double-sided, it needs very specific information about the actual printer you're using. If your printer model is not in ClickBook's
list, it's best to use the Custom Printer Setup Wizard.

.5 Custom Printer Setup

If you are unable to setup your printer with ClickBook's Easy Printer Setup, you can elect to use the Custom Printer Setup
Wizard.

Here's a summary of what Custom Printer Setup does: First, the program prints two (single-sided) pages and asks you a
question about how they printed. Next, you're instructed on how to reinsert the printout and begin printing the second pass.
Afterward, you're again asked to report on what the printout looks like.

To use the Custom Printer Setup Wizard follow these steps:

1. Make sure the printer you wish to setup is ready to print (turned on, online, paper loaded, etc.)

2. Open ClickBook Printer Setup, which is found in the File menu, or click the Windows Start button, go to Programs, Blue
Squirrel, and click on ClickBook Printer Setup.

3. Choose your printer model from the Printer list. Doing so, will enable Custom Printer Setup radio button.

4. Click the Custom Printer Setup radio button. When you're ready to start press the Setup... button.

5. The Custom Printer Setup Wizard - Overview dialog appears. Follow the instructions presented on the screen.

Custom Printer Setup Wizard - Overview

The Printer Setup “izard will walk you through 5 simple steps.
Twa of which you will receive printouts for.

@ | IMPORTAMNTI @

E ach time vau handle the printouts, it's CRUCIAL that pou preserve the ORDER and
ORIEMTATIOMN of the pages. Pleaze hold the printouts az though the bwo sheets were
GLUED TOGETHER, nat rearranaging them, nar looking at the inside pages.

[ | will uze the hand fed bray for the second side. v Turn on woice prompks

:

MHewt » Cancel

6. If you want to use a hand fed tray for the second side printing pass please mark the check box next to "I will use the hand
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fed tray for the second side."
Please repeat steps 1 through 5 to setup a second, third or fourth printer.

(NOTE: Itisvery improtant that you follow theinstructions carefully to ensure proper setup of your printer.)

There are 2 common mistakes made when using the Custom Printer Setup:
1- Not keeping the pagestogether preserving the page order
2- On Step #5, not finding the side printed with the arrow, then comparing the printouts.

2.6

Setting Up A Duplexing Printer For Use With ClickBook

Using a duplexing printer (one that automatically handles double-sided printing) with ClickBook is easy. ClickBook sends out
only one print job for both the front and back sides, so you skip the step of reinserting the printout stack and then printing the
second print job.

Follow these steps to prepare your duplexing printer:

1.
2.
3

4.
5.
6

7.

First, make sure that the printer is installed in your Windows system

While in standalone mode, go to File on the menu bar and click on ClickBook Printer Setup.

Choose your printer model from the Printer list. Please ensure that you have already setup your printer to work with

ClickBook. If you have not, please follow the Easy Printer Setup instructions to do so, before moving onto step 4.

Click the Properties... button

Choose Automatic duplexing.

Select the printer style. There are 4 different styles of duplexing printers. They are:

e Style 1 - Standard duplexing is the most common duplex style. This is the default setting. Duplexing is based on the
orientation of paper where short edge represents the horizontal edge.

e Style 2 - The Reverse Duplexing style is the opposite of "Style 1". Commonly used by PostScript drivers. Duplexing is
based on the orientation of the paper where long edge represents the horizontal edge.

Click OK.

Note: If you are printing a booklet with ClickBook, and you only use a duplexing printer, ignore any Help that concerns
reinserting the paper before printing the second side.

2.7

Uninstalling ClickBook

To uninstall ClickBook from your computer please follow these steps:

akrw

Click the Microsoft Windows Start button on and select Control Panel from the Start Menu.

Double click the Add/Remove Programs Icon (Programs Icon in Vista), and the Windows Add/Remove Programs
Properties dialog box appears.

Select Blue Squirrel ClickBook in the list of software available, and click the Add/Remove button.

The following dialog confirms your request to uninstall.

If you are certain you want to uninstall ClickBook click the Yes button.
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3.1 ClickBook's Main Screen

ClickBook's main window is divided into five separate parts: Menu bar , Toolbar , Print Jobs, Status bar, and Print Preview.

& (GlickBopkaPrinter v A=
File Lawouts Miew Tools Help
- = - = 47

Qpen  Save Prink PDF Email | Options Poster  + Page Help Samples '-.-'|5|I: s F'.I:u:uut

1=l -
F'rir_1t
Bk Presvigw

Print Status
Al Pages Received : & Pages

Print Options

| PaperPart Colar Image ﬂ Print
| |

Enter page numbers and/or page ranges separated by Ll_l M

commas. Example: 1,3.5-12 Sheet #1 [front]

# Copies El 1 n Front Back | Sheet 5 election—
* Jobs ¢ Pages Categories Layouts

Title Pages .

Elvicrassft word - . l . ges | Pt Job & ook j ‘ | Side-BySide (fold: v

Thiz lapout was designed to make a folded boak, with 8

mini-pages ko 1 sheet of bz bppically uzed on .
e M N I P o [ e 1 o
4 r »
This Job : 8 Pages - 75% Paper Saved | Total Printed : 0 Pages - 0% Paper Saved PN

e The Menu Bar offers access to commands organized into menus.

e The ToolBar offers one-click access to the most commonly used commands.

e Print Jobs allows you to print all or a range of pages, determine how many copies to print, which printer will receive the
print job, which applications are going to be printed, and allows you to remove unwanted applications.

e Print Preview provides an idea of what the document will look like when it is printed for the chosen layout.

o Status Bar displays the total amount of pages that will be sent to the printer, how much paper you will save, and if the Ink
Saver feature is enabled.

3.2 Toolbar

The ClickBook Toolbar offers one click access to frequently used commands.

=T NET @ A e o

CIpEn Save Print PDF Email Cptions  Poster  + Page Help  Samples  Wisit Us  Abook
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J

UPEN  The Open File dialog box appears where you can open an existing ClickBook (.cb) file.

& | The Save As dialog box appears and allows you to save the current project as a ClickBook (.cb) file.
PAnt | Sends the current project to the printer(s).

Create a PDF file.
Ernail - .
mal Opens your default email client and attaches the PDF file you created.

Cptians The Options dialog box appears where you can change print settings, program settings, and paper/border settings,
and header/footer/watermark settings.

Foste | The Poster Wizard lets you create posters of any size or shape. (Windows Vista, XP, 2000, 2003 only)

= - . .
e Will insert a blank page in the Print Jobs.

Help This option launches the ClickBook Help File. Use this option to learn how to use ClickBook, or to answer specific
questions on ClickBook functions.

A

Samples Displays a short explanation for the selected Layout at the bottom of the Print Preview Window.

oY

Wisit LI .
== 1 Launches your default Internet browser and opens the Blue Squirrel Home page.

(i)

About Displays version and copyright information about ClickBook.
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3.3

Print Jobs

Print Jobs displays information pertaining to the files received from their corresponding applications. It also allows you to print
all or a range of pages, determine how many copies to print, and which printer will receive the print job.

=l x|
Print Status

All Pages Received : 4 Pages

Print Options

| \MAHP Laserlet i ~| Print
| L |

Enter page numbers and/or page ranges separated by
commaz. Example: 1,3.512

# Copies |=[1 [ Use Hand Fed Tray
* Jobs  Pages
Title | Pages |

[l http: /v, googl,.. 2
[#] http: /v Fitein, .. 2

Lists the title and amount of pages received for each file.

Select a file and use your mouse to click-and-drag it to rearrange the print order.

Uncheck items to remove files from the project.

Print Status displays how many pages ClickBook received from the application program.

Printer drop down menu lists the printers you have setup to work with ClickBook, and the current chosen printer will
receive the print job.

Print Sends the current files that are listed in the Print Jobs to the printer.

Page Range can be used to print specific pages or a range of pages. The page numbers are determined by
the red numbers on the Print Preview Window. For example, [1-5,9,15] will print pages 1 through 5, page 9, and page
15. ClickBook will skip pages 7,8, and 10 through 14.

# of Copies lets you enter the amount of copies to print.

Choosing Jobs lets you re-arrange print jobs in your booklet. Choosing Pages lets you drag and drop pages and re-order
them in any order.
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3.4 Print Preview

The Print Preview screen displays the following:

Select Sheet
Selection and
enter pages

wou wizh to
print.

Sheet #1 [frant]
Eront Back |
Categories Layouts

f-‘«ll j ‘ 1 !HitelnTheHainLj

Thiz layout waz designed to make a cut book with 4 mini- A
pages to 1 zheet of paper. The mini-pages are punched out
and then asszembled into the booklet. [tis typically used on

Shows you how the selected layout for the Print Jobs will look once it is sent to the printer.
Scroll arrows offer front-side and backside page navigation.
Drop down menus allow you to select various categories, and Layouts.

Sheet Selection allows you to print just the front, back or both pages of a document, as well as, determine which pages to
begin and end printing.

Brief description pertaining to the selected layout.

3.5 Status Bar

The Status bar provides information pertaining to the current Print Jobs.

This Job : 4 Pages - 75% Paper Saved | Tatal Printed : 10 Pages - 253 Paper Saved Ik Saver aff | [HLIM | v

o Paper Saving Meter displays how much paper you will save with the current printout, and how much paper you have
saved overall by using ClickBook.

o If you are printing a poster, the status bar changes to give you information about the poster you are printing.
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4.1 Sample Documents

ClickBook comes with sample documents for each layout. Most of the documents are Microsoft Word documents that can be
used as a starting point when creating booklets, tri-folds, french folds, labels, etc.

The reason for including sample documents is that some of the layouts require specific margins, or number of pages to work
properly with the layout. The sample documents will be pre-set with those pages, margins and other page settings.

To use a sample document, simply choose the layout you wish to use, then hit the Samples button on the toolbar, or choose
Help->"Sample Documents..." and then hit "Use this layout with its sample document"

The sample document will be loaded up in Word or other word processor and you can modify the contents to meet your
needs.

4.2  Printing A Multi-document Booklet

Summary: To print several documents as a single booklet, just wait to click ClickBook's Print button until after you have sent
all the documents to ClickBook.

When you send a document to ClickBook, the software program opens and begins receiving and processing the document. If
you send a second document, as long as you have not yet clicked ClickBook's Print button, the second document becomes
part of the same booklet. You can send a third document, and so on. The documents can come from different applications,
but must be sent to the same printer.

Note: If you want to print from many applications, you can close each application as soon as it has finished printing (sending
the pages) to ClickBook. This may help if you find that you don't have enough memory, or that your computer is operating
slowly.

Once you have sent all of the desired documents to ClickBook, you can adjust settings — for example, select a different layout.
Notice that all of your desired documents in the Print Jobs box. If you want to cancel any of your documents from printing just
click on the check mark in the box next to the documents name. If you want the documents to print in a different order just left
click and hold on the document you want to move and slide to the desired order of the print job.

Finally, once you have verified the contents of the booklet and you are ready to print, click Print.
Important: The defining document

The first document you send to ClickBook for a given booklet is the defining document. ClickBook uses the following settings
from the defining document for all the documents you print together as one booklet.

Page settings (set these in your application or through Windows printer setup):
Page orientation (portrait/landscape)

Page width and height

Layout (set in ClickBook)

Tip: To make sure the settings match, or to find out what the discrepancies are, you can view a list comparing any document
with the defining document. Just select that documents name (in the Print Job box) and then right-click.

Ensure that you send all documents to the ClickBook printer. Some application programs remember the printer last used for
each document. If your application does this, check the printer for each document before giving the print command.

Printing multiple documents as separate booklets

If you wish to print multiple documents as separate booklets one immediately after another, simply click ClickBook's print
button for one document before you send the next document to ClickBook. Or , if you send documents to different printers,
each printer's set of documents will be printed as a separate booklet.
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Poster Wizard

Poster Wizard

x]

Width ; E El |Inches j
Height: | 31.06 El |In|:hes j

v PMaintain document azpect ratio [zhape]
850"« 117.00"

f# Stretch to fit
" Size tofit [1:7]
™ Banner # Crop [1:1]

Save bz | Diane |

Cancel | Help | """""""""""""""""""

Total Pages : 15 Pages of 11.00" = 8.50"

The Poster Wizard is a quick and easy way to make a poster or banner (Windows XP, 2000, 2003, Vista only). You choose
the size of your poster or banner, and ClickBook will automatically determine the pages needed to create it.

If you choose Maintain document aspect ration (shape), you can change Width OR Height and the other one will be
calculated for you to keep the poster the same shape as the source document. If you haven't printed a document to
ClickBook yet, it will keep the same shape as your default paper setting. Using this option will make it so it does not matter
whether you choose Stretch to fit, Size to fit (1:1) or Crop/Banner.

Stretch to fit will stretch your source document to fit the poster size. Photos may not look right if stretched too much.
Stretched letters usually look fine unless stretched too much.

Size to fit (1:1) - will make your document fit and not be stretched. ClickBook will center the document if you have made the
poster size too wide or too tall. This is a good option if you have photographs.

Crop /Banner (1:1) - will make your document fit in one direction only, and crop off the rest if the poster/banner is not the
same shape as the source document.

Save As... allows you to save your custom poster size as a hew layout.

A banner is a just a really wide, or really tall poster. If you want to do a banner, you should choose Crop/Banner and only
the top part of your document will be printed. In your application (like Microsoft Word), you would put your words like
"Congratulations to Johnny on making straight A's" at the top of the Word document. The bottom part of the Word
document will be "Cropped" off and not printed on the banner.

See information on the assembly of your poster.
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More options for your custom poster are available under Layouts->Modify Layout...

4.4  Layout Wizard

The Layout Wizard is a simplified process to change settings for a particular Layout.

To use the Layout Wizard proceed as follows:

PPk

4.5 Modify Layout

Open the Layout Wizard. From the Menu Bar select layouts and click on the Layout Wizard.
Make desired changes and click Next to proceed through the steps.
If, at any time, you want to quit the Layout Wizard click Cancel.

The Modify Layout dialog box allows the user to make permanent changes to any layout format. It also allows the user to save
their changes as a new layout by selecting Save As or to save their changes over an existing layout by clicking done.

To access the Modify Layout dialog go to Layouts on the menu bar, and select Modify Layouts.

Fdif
Booklet Style B . .
Booklet Type - Sheet Orientation :  Mini-pgs. on Sheet :
fe | andecape 2 El Aecross

|F':'|'j'3d Book j " Portrait |-|_ E Dawn

[ Anti-Shingle [

Binding - o

P Ttier Plepres Sl Binding Edge :  Print Sides :

|L —~— J * Standard ¢ Single Sided
elter 5ma =l Fip " Double Sided

Sub Booklets Scaling

|_ [ &bgolute Dimensions  Scaling ;

[ Subbooklsts || yidth ;|

I_ El Faz. per

kd argins
Paper Marginz :

Top: WE
Left: D00 F]
Bottorn : |0.00" El
Right: (000" |

||

Cateqaries

| Books= j

E |Stret|:h b fit j Layouts

Height ; El [

Mini-page Margins :
Binding ; ||:|-|:":| " El
Top/Battom : ||:|-|:":| " E
Left/Right - [0.00" [

| [

Change ||:|:|n...| [ MoRed Lines

I'I_ El Carbonless Copies  Carbon #

Forr:

| Browse...

[ Form only on first page

Thiz lapout was designed to make a folded boak, with 4 mini-pages to 1 theet of paper. The mini-pages are
folded down the center and then stapled into a book. 1t i twpically used on documents of 4 to 80 pages. Thiz ==
lapaut will gtretch the document ba fit the baoklet 2o your graphics will be adjusted. It can be used to print

Save bz

| Dane | Abandon Changes |

Help Cancel

e Booklet Style:
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e Booklet Type - Select a booklet style such as Cut book, Folded book, French fold, Planner pages, Poster, Tiled, Tri-
fold and Zine.

e Anti-Shingle - In large folded booklets with more than 10 sheets of paper the edges start to creep out in the center
until the edge looks like a V. We call this shingling. ClickBook can move the page towards the center so you can cut
off excess paper without cutting into printed text.

e Mini-pgs. on Sheet - Select how many pages to put on a single sheet of paper.

e Sheet Orientation - Select if you want the sheet to print in Portrait or Landscape Orientation.

e Binding

e Printer Paper Size - Select the size of paper you want to use. This will override the default setting that is under Tools-
>Options.

e Binding Edge - Choose how you want the binding edge.

e Print Sides - Select to print on one side or both sides of paper.

e Sub Booklets

e Repeat - The effect of Repeat depends on the current Layout. Repeat can be used to print more copies when there
aren't enough mini-pages to fill the sheet. Repeat can also be used, alternatively, to avoid the step of assembling
multiple booklets.

e Sub-Booklets - Rather than folding a whole booklet together, you may wish to print and fold sub-booklets separately,
and then bind them together. Mark the check box to activate sub-booklet printing. Then set Pages-per to the number
of pages you want each sub-booklet to contain.

e Scaling

e Absolute Dimensions - ClickBook sets the Mini-page dimensions to fill a sheet of paper. You can set the dimensions
by turning on Absolute Dimensions.

o Width - Specify the width to match a custom page size.

e Height - Specify the height to match a custom page size.

e Scaling - Choose the type of scaling to use, either One to One, No Scaling, or Stretch to fit.

e Margins
e Paper Margins - Allows you to change the margins for a sheet of paper.
e Mini-Page Margins - Allows you to change the mini-page margins for the current Layout.
e Categories - Lists all of the types of layouts ClickBook offers.
e Layouts - The drop down menu lets you select a desired print out.
e Change Icon - If you are saving a custom layout you can change the icon graphic associated with the layout.
e Carbonless Copies - Input the amount of carbonless copies you would like to print for a specific form.
e Carbon # - Adjust settings for carbonless copies.
e Form - Allows you to add custom forms and/or Letterhead. (Leave blank for no forms to print.)
e Form only on first page - Only prints selected form on Page #1
e Layout Description - Gives you a brief definition for the selected layout.
e Save As... - Opens the Save As dialog box to save the layout with a new name.
e Done - Saves any changes made to the current Layout.
e Abandon Changes - Reverts to the layout's previous settings.
e Cancel - Closes the Modify Layouts dialog.

If you set the Booklet Type to Poster (Windows XP, 2000, 2003, Vista only), you get other options:

e Paper Orientation - This lets you choose the orientation of the pages in the poster.

e Pages on Poster - This specifies how many pages will be printed per poster. Across specifies the number of pages
going horizontally, and Down specifies the humber of pages going vertically.

o Poster Margins - The top and left margins specify how far over the poster will begin printing from the upper-left corner of
the first piece of paper. In most cases it makes sense to leave these at 0, unless you are missing part of your poster
because of the non-printable area of your printer.

e Poster Cropping - This will stretch your document to fit the poster in one direction and crop off the other dimension if the
document does not fit exactly.
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e Scaling (Width/Height) - This is the total width and height of the poster after assembly.

e Overlap - This specifies how much overlap in each poster page. The pages intentionally overlap because most printers
cannot print to the edge of the paper so there would be white gaps on the poster. You should trim off the white non-
printable area before taping the poster together.

4.6 Assemble a Booklet

To turn on the Assembly Instructions:

=

1. Click the Options button Optians on the toolbar. This will bring up the Options dialog box.

2. Choose the Print Settings tab and click in the box next to Print assembly instructions.

3. Click OK.
| IO, Lﬂ]

Email Settingz ] PDF Security ] PDF Settings ] Puoster ]

Program 5 ettings ] Headerz ] Footers ] W atermark z ]
Frint Settings l Faper, Borders ]
[v Frint cut marks on the first page and on eveng W th page.
[v Print second side instructions.
[ PFrint azzembly instructions.
[ Frint info sheet.
[ Print a Table of Contents page.
[ Force all booklet pages to have the zame anentation.
[ Enable adjustable Mini-pages.
[ Print page nurnbers the same as the coresponding page number,
v Print without images
[ Beverse Printing

k., | Cancel Help

4.7  Cutting And Assembling a Booklet

The cut marks on the printout are guidelines that show between which mini-pages to cut. Their position is accurate to about
1/16", which is not high precision for very small mini-pages. Use your eye or measure, in order to cut precisely halfway
between mini-pages.

The marks themselves tell you the order of the cuts. The solid line indicates the first cut, the line composed of two dashes
indicates the second, the line composed of three dashes indicates the third, and so on.
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The instructions below, or those printed with the printout, include the important information about how to re-stack the cut
sheets after each cut. They give the general rules for cutting and assembling any book of any layout.

1. If the mini-pages do not fill the sheet (that is, if you specified absolute mini-page dimensions), the first step is to cut away
the extra paper. If there is no extra to cut away, skip to step 4.

2. Cut at the "one-dash" cut mark, which indicates a vertical cut to eliminate extra paper on the right. Discard the
extraneous strips.

3. Cut at the "two dash" cut mark, which indicates a horizontal cut to eliminate extra paper at the bottom. Discard the
extraneous strips.

4. Make the leftmost vertical cut. (Look for the next cut mark. Depending on whether you did steps 1.a. and/or 1.b., this
may be composed of one, two or three dashes.)

5.  Now your printout is split into two stacks. Place the one with page 1 on top of the other, aligning the top left corners.

6. Make the leftmost remaining vertical cut, if any.

7. Again, place the page 1 stack on top of the other, with top left corners together.

8. Continue in the same way until all vertical cuts have been made.

9. Make the top horizontal cut.

10. Place the page 1 stack on top of the other, with top left corners together.

11. Make the topmost remaining horizontal cut if any.

12. Place the page 1 stack on top of the other, with the top left corners together.

13. Continue in the same way until all horizontal cuts have been made.

14. Be sure to fold and/or bind on the edge indicated by your choice of layout, namely binding on the left for a Standard book,
or on top for a Flip book. For a folded booklet layout: Remove blank mini-sheets, if any, from the middle. Fold in half and
staple. For a cut book layout: Remove blank mini-pages, if any from the end. Then bind.

Cutting options:
Paper Trimmer - See our paper trimmers at http://www.bluesquirrel.com/so/trimmer/

Binding options:
Staple (also called a saddle stitch) - See our specialized staplers at http://www.bluesquirrel.com/clickbook/staplers.asp

4.8 Assembling a Poster

ClickBook makes poster creation easy (Windows Vista, XP, 2000, 2003 only).

Steps:
1. Print your document to ClickBook
2. Use Poster Wizard to create a poster of any size.
3. Click the Options tab on the toolbar. Select the Poster tab, and mark check boxes for instructions that you want printed.
Press OK to save changes.
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Options §|

Email Settingz ] Headerz ] Footers ] W atermarkz ]
Prit S ettings ] Paper, Borders ]
Foster l Frogram Settingz ] FOF Security ] FDF Settings ]

[v Print azzembly instruchions

[v Print pozter edge mark.s.
[vw Print page cut marks.

[vw Print pozter azzembly number [top left carner].
f+ fAz %y coordinants

" Az atile number

] | Cancel Help

4. Hit print from ClickBook to print to your printer.

Once you've printed your poster you will have a stack of paper. ClickBook has been designed so that you should be able to
take the stack and lay the pages out from left-to-right and then top-to-bottom, the same way that you read.

We suggest that you trim off the excess white space. The white space is because of the non-printable area of most printers.
Once you trim off the white space, you can line up each page with its previous page and tape it together.

Options for fastening the pages together include:
e Staples
e Tape

Glue onto poster board

Staple directly to a wall or bulletin board
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Trimming Hints:

You do not have to trim every side of every page because you can overlap the pages. The pages are printed so that there is
some overlap. This overlap helps you line up the pages. By default, there is a one inch overlap for each poster page. The
non-printable area takes up some of that one inch overlap, and should be trimmed off. If you don't want any overlap, trim off
exactly one inch from the left side of each page (except the pages in the first column), and one inch from the top (except the
pages on the first row).

4.9 Creating a Banner

You can use ClickBook to create a banner of any size (Windows Vista, XP, 2000, 2003, Vista only). And you can use your
favorite program to make the banner.

Our example uses Microsoft Word, but you can also use WordPad which comes with Windows, or any other Windows
program.

The key to creating a banner in ClickBook is to make your text go all the way across the paper in your source document. The
easiest way to do this is to increase the font size until you've gone across the paper. You should set the paper margins to 1/4
inch in Page Setup... in Microsoft Word to make sure you go all the way across the paper.

Welcome Home Charlie Welcome Home Charlie

WRONG

You can also make tall banners. Have the text go down the left side of the page from top to bottom.

You are not limited to one line of text for your banners. Just make sure the longest line goes all the way across the page.
Also make sure you put your text at the very top of the page.

Steps:
1. Print your document to ClickBook
2. Choose the Poster Wizard
3. Choose Crop/Banner (1:1) from in the Poster Wizard
4. Choose how wide you want your banner, and how tall you want your banner

Tip: When choosing how wide and how high you want your banner, keep in mind the shape of your banner. In the example
above, you might make it 6 feet long and 1 foot high to keep the right shape. Or 12 ft x 24" also works. But 12 ft x 15" is not
the right shape and does not work. See the examples below. The width will always fit. You should adjust the height of the
banner to make sure you don't chop off the bottom of your text.

6ftx 12" (RIGHT)
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12 ftx 24" (RIGHT)

12 ft x 15" (WRONG)

L [Py s R gL MRS [

Tip: Center your text at the top of the page, and then increase the font until your text goes edge-to-edge.

4.10 Making a PDF file

ClickBook can make PDF files. Choose your layout, and hit the PDF button FDF on the toolbar. Name your PDF file and

choose Save.

The Save dialog has an option PDF Security... which lets you set an owner password, a user password and set limits on what
users can do with the PDF file.

Qﬁ

Email - Auto Email PDFs - ClickBook will use your default email client to quickly send converted PDF files to friends, family,

and colleagues. You can use this feature to quickly email PDF booklets, PDF brochures, PDF banners, PDF posters, and
more. Once you have created and saved your PDF file simply click on the email button on the toolbar. Your default email
client will open with the PDF as an attachment. You can select the person you would like to send the PDF to, type in a

message, and send the email as you always have. Y ou can now email using your SM TP Server settings.

To setup your SMTP Server Settings.

=

1- Goto Cptions
2- Thenclick on the'Email Setting' tab.
3- Click OK to saveyour settings.
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-,

Options
Program Settings ] Footers ] WWiatermarks ]
. F"r.int S eting ytﬁ?éiﬁ% F'aper., Borders ]
Ernail Settings settings from FDF Settings ] Paoster ]

woLr Ermail

" ze MARI

Lookup...

From Address :

Server :

lzer Mame :

Paszword :

[ Usze S5L [part 465)

Test

E-mail Hiztary : | ﬂ

Clear E-mail Higtary |

| k. | Cancel | Help

4.11 Printing a PDF booklet

Printing a booklet from a PDF works best if you have a duplexing printer that prints automatically on both sides. In the printing
options, set to "Flip on Short Edge"

4.12 Quick Click Printers

Quick Click Printers allow you to automate the printing process, and send print jobs directly to the printer without ClickBook
intervention. You can instantly print side-by-side folded booklets, convert to PDFs, or print flipbooks with a single click. You will
setup a ClickBook printer with your preferred layout. ClickBook will then make a custom Quick Click printer that is tied to your
printer and a specific ClickBook layout. The Quick Click Printer will always print the same way each time to your printer. You
can even setup a PDF Quick Click printer that will automatically convert files to PDFs, email them with your default email
client, and add any encryption or password preferences. No more hassle thumbing through all of the layouts, simply setup a
Quick Click Printer and let ClickBook handle the rest. By default there are two Quick Click Printers setup. "Side By Side
Folded" prints standard 8.5x11 side-by-side folded booklets, and the second "PDF Converter" converts files to PDFs.

To setup a Quick Click Printer follow these steps:

1. Open ClickBook and go to File, and select Quick Click Printers. The Quick Click Printers dialog will appear.
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2.

Sl

6.

Click on New and type in a name for your custom Quick Click Printer.

Quick Click Printer Mame

Enter the new name of the Quick Click Printer.

\Side by Side Folded

Cancel

Select a layout from the drop down menu.

Choose a radio button to Print Immediately or Open ClickBook.

Select your printer from the Print To drop down menu. Please note, If you would like to use the hand fed tray on your
printer you'll need to mark the check box next to the Print To drop down. If the hand fed tray option is greyed out you will
need to setup a standard ClickBook printer first with the hand fed option. See Automatic Printer Setup for instructions.
Press Close when you are done.

To setup a PDF Conversion Quick Click Printer follow these steps:
1.
2.
3.

4.

Open ClickBook and go to File, and select Quick Click Printers. The Quick Click Printers dialog will appear.

Click on New and type in a name for your custom Quick Click Printer.

Select a layout from the drop down menu. Note, if you want your PDF file to be a standard 8.5x11 size choose the layout
"1-UP (Fax) Portrait".

Choose a radio button to Print Immediately, which will convert to a PDF without opening ClickBook, or choose the radio
button to Open ClickBook.

Select the ClickBook PDF Converter printer from the Print To drop down menu. Doing so activates all options for the PDF
Settings.

Mark check boxes alongside the items, such as Save In, Email To, and Encryption that you wish to set custom
preferences.

Marking the check box for Save In allows you to set a specific location on your hard drive where you would like to save
and store PDF files.

If you check the Email To box this allows you to enter an Email address that you will frequently send PDF files to, and the
Email Message section allows you to type a text message to the receiver.

Marking the check box for Encryption gives you options to set a password and ask for the password, detect whether you
want 40Bit or 128Bit encryption, and assign rights to viewers. Mark the check box Change PDF if you want viewers to
have the right to edit the PDF. Mark the check box next to Print PDF if you want viewers to be able to print the PDF. Mark
the check box Copy Text if you want readers to have permission to copy and paste text. Mark the check box for Add Notes
if you want give readers the option to add notes to the PDF file.

7. Click Close to exit the Quick Click Printers dialog box.

© 2009 Blue Squirrel



Advanced Options 27

5.1 Forms and Letterhead
ClickBook hasthe ability to create el ectronic formsand | etterhead.

After you creat a form in ClickBook you can set ClickBook to use that form in the Modify layouts screen. The ClickBook preview
feature will show how your output will appear before you print it. This ensures that your document is aligned correctly with
the form you have selected.

ClickBook comes with 3 sample forms/letterhead:
1. Blue Squirrel Letterhead.cbf

2. Purchase Order.cbf

3. Sample Background.cbf

How to create a form:

Create a form in a separate application, like you would a normal document (1 page only), then print it to ClickBook.
Select the layout named: 1Up(Fax)
Then go to File> Save As Form.

The Save Asdialog will Open, and it will default to your My Documentsfolder.
Browseto the directory you want to save theform to.
Nametheform and click Save.

oA wWNE

How to select a form to print in ClickBook
To selecte a form to print in ClickBook all you have to do is select the form from the Modify Layouts screen.
1. Print your document to ClickBook

2. Select the layout you want to print with.
3. Go to Layouts> Modify Layouts (or right click on the preview and go to Modify Layouts.)
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4. Click on the 'Browse' button next to foms to select the form you want to print with the selected layout. (This form will be

associated with this layout each time until you remove the form.)
5. Browse to the location you have your ClickBook forms saved to.

6. Select the Form to use and click Open.
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7. Now check the preview to ensure that your document looks correct.
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TIP: You can setup Quick Click Printers to use Forms as well, simply set the form in the layout that you are using for the Quick
Click Printer.

5.2

Insert A Header

You can add a header to the top position of each mini page. You can select a separate font, color and size for each type. We
have also provided four buttons that will insert the print job name, date, time and page number into the header.

Job — <job> inserts the name of the first job listed in the Print Job bar
Date — <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time — <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
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Page — <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of
4 when used on a mini-page that is 4 times smaller than a regular sheet of paper. This makes it easy to set up a header,
footer, or watermark that can be used for different booklet types as the text will be automatically sized for each booklet.

To place a Header on your current print job follow these steps:

1. Click the Options button on the toolbar. This will bring up the Options dialog box.

2. Select the Headers tab.

3. Inorder to print a header a check must be placed next to the Print Headers field. Note: Header can be permanently shut
off by un-checking the "Print Headers" checkbox.

5. Type your message in the text field box and/or select any of the following buttons
o Job: places the title of the first print job listed in the Print Job window.

o Date: Places today's date.
e Time: Places the current time.
e Page: Places the page Numbers.

6. To change the look and feel of the Header click the Select Font button. The Font window will open and from here the
Font, Font Style, Size, Effects, Color, and Script can all be changed. The Sample window will demonstrate how the
changes will appear.

7. The Text justification allows you to choose where the Header will be placed: right, left, or center. Place a mark next to the
desired position.

8. The Start printing Headers on page option allows you to choose which page the Headers will begin. Note: This feature
allows you to start the process of printing Headers on the mini-page of your choice. This is useful for when you have a
cover page and you don't want the page number to be printed on that page. Please note that the page numbering will
start on the page you choose. For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers on page option allows you to choose which page the Headers will end. Note: The default
setting of O will end the printing of Headers on the last page.

10. Click Apply Changes to view any modifications you have made to your headers. The changes will appear in the print
preview window. If the changes are acceptable Click OK. Headers will now be placed on your print job.

Note: Headers are not printed on posters.

5.3 Insert A Footer

Adding a Footer will place a line of text in the bottom position of each mini-page. You can select a separate font, color and
size for each type. We have also provided 4 buttons that will insert the print job name, date, time and page number into the
footer.

Job — <job> inserts the name of the first job listed in the Print Job bar

Date — <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time — <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page — <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of
4 when used on a mini-page that is 4 times smaller than a regular sheet of paper. This makes it easy to set up a header,
footer, or watermark that can be used for different booklet types as the text will be automatically sized for each booklet.

To place a Footer on your current print job follow these steps:

1. Click on the Options button on the toolbar. This will bring up the Options dialog box.

2. Select the Headers, Footers, and Watermarks tab.

3. Inorder to print a header a check must be placed next to the Print Headers, Footers, & Watermarks field. Note: Header,
Footers, and Watermarks can be permanently shut off by un-checking the "Print Headers, Footers, & Watermarks "
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checkbox.
4. From the drop down menu select Footer.
5. Type your message in the text field box and/or select any of the following buttons:
o Job: places the title of the first print job listed in the Print Job window.
o Date: Places today's date.
e Time: Places the current time.
e Page: Places the page Numbers.

6. To change the look and feel of the Footer click the Select Font button. The Font window will open and from here the Font,
Font Style, Size, Effects, Color, and Script can all be changed. The Sample window will demonstrate how the changes
will appear.

7. The Text justification allows you to choose where the Footer will be placed: right, left, or center. Place a mark next to the
desired position.

8. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers,
Footers, and Watermarks will begin. Note: This feature allows you to start the process of printing Headers, Footers, and
Watermarks on the mini-page of your choice. This is useful for when you have a cover page and you don't want the page
number to be printed on that page. Please note that the page numbering will start on the page you choose. For example
if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers
Footers, and Watermarks will end. Note: The default setting of O will end the printing of Headers, Footers, and
Watermarks on the last page.

10. Click Apply Changes to view any modifications you have made to your headers, footers, or watermarks. The changes will
appear in the print preview window. If the changes are acceptable

11. Click OK. Footers will now be placed on your print job.

Note: Footers are not printed on posters.

5.4 Insert A Watermark

Adding a Watermark will add a graphic or text in the diagonal position of each mini-page. You can select a separate font,
color and size for each type. We have also provided 4 buttons that will insert the print job name, date, time and page number
into the watermark.

Job — <job> inserts the name of the first job listed in the Print Job bar

Date — <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time — <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page — <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of
4 when used on a mini-page that is 4 times smaller than a regular sheet of paper. This makes it easy to set up a header,
footer, or watermark that can be used for different booklet types as the text will be automatically sized for each booklet.

Note: Watermark graphics must be in bitmap (.bmp) format. The graphic colors will not be changed in any way and will
appear the same way it does in your graphic editor. You may want to lighten up the graphic before using it as a watermark so
the text in front of it does not get washed out. You can do this with most graphic editors and word processors. ClickBook
uses a point for point system for sizing the graphic and will allow you to scale the watermark from 10 times its original size to
1/10 its original size. For example, a 600 by 600 pixel graphic would be 1 inch on a mini-page using a 600 dpi (dots per inch)
printer. To make the graphic 2 ¥ inches or 2 % times bigger enter 2.5 in the edit box below the Graphic button.

To place a Watermark on your current print job follow these steps:

=

1. Click on the Options button Options on the toolbar. This will bring up the Options dialog box.

2. Select the Headers, Footers, and Watermarks tab.

© 2009 Blue Squirrel



oaks

11.

12.

Advanced Options 33

In order to print a header a check must be placed next to the Print Headers, Footers, & Watermarks field. Note: Header,
Footers, and Watermarks can be permanently shut off by un-checking the "Print Headers, Footers, & Watermarks "
checkbox.

From the drop down menu select Watermark.

Now select the desired radio button to include a Text or Graphic Watermark.

If Text has been chosen you may now decide what information is to be placed in the Watermark. Options include placing
the following:

o Job: places the title of the first print job listed in the Print Job window.

o Date: Places today's date.

Time: Places the current time.

Page: Places the page Numbers.

Textbox: Type text as you want it to appear.

To change the look and feel of the Watermark click the Select Font button. The Font window will open and from here the
Font, Font Style, Size, Effects, Color, and Script can all be changed. The sample window will demonstrate how the
changes will appear.

If Graphic has been chosen you can browse to the location of the image and select it or type the location of the image in
the text field.

The Scale watermark graphic times the original size field allows you to make the image larger or smaller as desired.

. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers,

Footers, and Watermarks will begin. Note: This feature allows you to start the process of printing Headers, Footers, and
Watermarks on the mini-page of your choice. This is useful for when you have a cover page and you don't want the page
number to be printed on that page. Please note that the page numbering will start on the page you choose. For
example, if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers
Footers, and Watermarks will end. Note: The default setting of O will end the printing of Headers, Footers, and
Watermarks on the last page.

Click Apply Changes to view any modifications you have made to your headers, footers, or watermarks. The changes will
appear in the print preview window. If the changes are acceptable click OK. A Watermark will now be placed on your print
job.

Note: Watermarks are not printed on posters.
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5.5 Add Page Numbers

To Add Page Numbers to your ClickBook printouts follow these steps:
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=

Click on the Options button Cptions on the Toolbar, or click Tools on the Menu bar and select Options.

In the Options dialog box click the box next to Print Headers, Footers, & Watermarks.

Click the Page button. ClickBook will place the code <#> in the text box. You can add any additional text you want to
appear before or after the page number.

4. Click OK. Page numbers will now be placed in the top center position on each mini page for your print job.

5.6 Add A Border

wnN e

=

Click on the Options button Options on the Toolbar, or click Tools on the Menu bar and select Options.

In the Options dialog box click on the Paper, Borders tab.
In the Borders box you can select the type of border you want and the thickness of the lines.
Click OK. A border will now be placed around your print job.

PoNE

Note: Borders are not printed on posters.
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5.7 Drag And Drop

Once you've created a shortcut on your desktop, or on your Windows task bar to the ClickBook Printer you can easily select
files, and drag and drop them onto the ClickBook Printer icon. Then ClickBook will automatically launch the program the file
was created in, and print the file to ClickBook . This is a great way to speed up the printing process.

To place a ClickBook Printer Shortcut on your desktop please follow these steps:

From the Start Menu, select Settings, then Printers. The Printer dialog box appears with a list of your printers.
Select the ClickBook Printer, right click, and click on Create Shortcut.

Windows will ask you if you want to create the shortcut on your desktop. Click Yes.

If you do not receive the Windows message simply activate your desktop, right click, and select paste shortcut.

PoNPE

5
ClickB oak

Wonderful! Now you can simply drag documents onto the printer icon == Printer .. to print using ClickBook .

To place a ClickBook Printer Shortcut on your taskbar please follow these steps: (Please note: in order to create a shortcut

on your Windows Taskbar you must have version |.E. 4.0 or later.)

1. Click on My Computer, and select Printers or from the Start Menu, select Settings, then Printers. The Printer dialog box
appears with a list of your printers.

2. Select the ClickBook Printer.

3. Click and drag the file onto your taskbar.

iiﬁtart”J ] & (=2 [E] @Shnrtcut to ClickBook Printer} @8 5:04 PM

Congratulations! Now you can easily Drag & Drop files onto your ClickBook Printer on the taskbar to quickly print booklets.

5.8 Instant Print

Instant Printing, or 1-step printing automatically starts the printing process without ClickBook program intervention. For
example, if you chose to print a document in Microsoft Word ClickBook would automatically print the file as a booklet without
opening the ClickBook software.

If you have already printed a document once, and print it again using ClickBook it will use the same layout settings previously,
such as, double-sided portrait to print the job. If you elect to print a different document ClickBook refers to the default layout
setting, which is double-sided booklet to print the job.

To enable Instant Printing please follow these steps:

=

Click on the Options button Options on the Toolbar, or click Tools on the Menu bar and select Options.

In the Options dialog box click on the Program Settings tab, and mark the Instant Printing check box.
Click OK. Instant Printing is how enabled!

wh ke

5.9 Delete A Page

Delete A Page removes pages from a booklet. This feature comes in handy when you're printing Web pages to eliminate the
last web
page with only footer information.
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To Delete a Page follow these steps.

Properties

ClickBook

Modify Lawout, ..
Poster Wizard...

Sheet #1 [front]
¥ Zoom Cut
Front B
S — Page Zoom
Categories

All 7

1. Goto Tools on the menu bar and select Delete a Page...
2. The Delete a Page dialog box appears.

3. Enter the page numbers for the pages you wish to delete in the text box. Refer to the red number located on the
document in the Print Preview window.

OR

1. Right-click on a page in the Print Preview screen and select Delete this page.
2. A confirmation dialog will pop-up asking you to confirm the deletion. Click Yes to continue and delete the page.

5.10 Print A Table Of Contents

ClickBook will add a Table of Contents to the beginning of your printout that will list the names of the files located in the Print
Jobs menu, and the page number where each file starts printing.

=

Options

To print a Table of Contents:

1. Click on the Options button on the toolbar. This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled Print a Table of Contents Page.
3. Click OK, and ClickBook will add a Table of Contents to the printout.

5.11 Print without Images

ClickBook now has the ability to remove images from the print job, allowing you to save ink when printing from Web Pages.
To remove images from a print job:

=

1. Click on the Options button Options on the toolbar. This will bring up the Options dialog box.

2. Choose the Print Settings tab and place a check in the box entitled 'Print without images'.
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3. Click OK, and ClickBook will will remove images from the print job.
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5.12 Reverse Printing
ClickBook can now print 'Hebrew Booklets' by utilizing the 'Reverse Printing' option.
To use reverse printing
1. Click on the Layouts> Modify Layouts. This will bring up the Modify Layouts dialog box.
2. Check the 'Reverse Printing' check box.
3. Click O.K. and ClickBook will now print your documents in reverse order.

NOTE: Reverse printing is not available for all layouts.

37
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Wodityayout %]

Booklet Style
Booklet Type :

Sheet Orientation :  Mini-pgs. on Sheet ;

* | andzcape |2_ El Across

Folded Book | ~ poorai [ E bown

[ Anti-Shingle [
Binding - -
e E Binding Edge :  Frint Sides : 1 8
|L o ai J * Standard  © Single Sided

elisrama 1 Flip # Double Sided
Sub Booklets Scaling Categaries

[ [ &bgolute Dimensions  Scaling ; |B|:u:uks j
[ Sub-booklets Width:| El |Stretu:h ko fit ﬂ Layouts

El Pgs. per | | Height : El | |Siu:|e-E=_l,l-Siu:Ie [folded) j

kd argins .
Bt e et Change |-:u:un...| [ MoPRed Lines

L El Binding - ]0.00 " El l'l_El Carbonless Copies  Carbon #
Left: |0.00" E Top/Bottom : |0.002 =

Botom: (000" ] LeftéRiight - |iY Check for
Right : IW E Reverze

Printing

Forri:

| Browse...

[ Foarm only on first page

Adjust Mini-pak

%

Thiz layout waz designed to make a folded book with 4 mini-pages to 1 gheet of paper. The min-pages are
folded dawn the center and then stapled into a boak. |t is bypically used on documents of 4 to B0 pages. Thiz

Save bz | Daone | Abandon Changes Help Cancel

5.13 Adjustable Mini-pages

Use the Adjustable Mini-Page feature to enlarge fonts and graphics and decrease the margins. You will input how far left,
right, up and down you want to reduce the mini-page margins to enlarge text and graphics.

To use this feature proceed with the following steps:

=

Options

1. Click on the Options button on the toolbar. This will bring up the Options dialog box.

Click OK, and ClickBook will enable Adjust Mini-page button L : in the Modify Layout dialog box.
From the Menu bar open Layouts and select Modify Layout. The Modify Layout dialog appears.
Choose the Adjust Mini-page button under Margins. The Adjust Mini-Page Dialog appears.

akrw
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Adjust the Margins to your liking. For example, to print an enlarged booklet with centered text you'll reduce the position
by .5 inch up, and to the left. The you'll need to compensate for the bottom and right margins by reducing them 1 full

inch.

Mark the check box next to Apply position 1 adjustments to all mini-pages if you want the adjustments to appear on all

pages of your booklet.

Press OK. Review the changes in the Print Preview, and repeat steps 1 through 6 to further adjust.

PDF Settings

Options
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To automatically make a PDF file when printing:

1- Click an the Program Settings tab and check |nstant Printing
2- Click the File-»Set Default ClickB ook Printer menu and zet the
T arget printer ta ClickBoak PDF Canverter.

&3

l
l

k. | Cancel Help
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AutoName - If you check this option, you will not be prompted to name the PDF file. The name will be derived from the
name of the document that you printed first.

Don't prompt when writing over a file with the same name - Check this option when you would like to replace previously

created PDF files with new PDF files. This option usually goes with AutoName. Then when you create a new PDF with the
same name, the old one will be overwritten.

Multi-Language Support (Unincode characters) - Allowsyouto convert unicodefonts, commonwith different
languaugefonts. Also allowsyou to convert 'Smart Quotes

Optimize the PDF file for the web - This option creates a PDF file that will load into a browser in stages. The first page will
be available to read while the other pages are still loading.

Change the colors to grayscale in the PDF file - This converts color documents to greyscale documents. Sometimes it is
easier to print a greyscale document on black and white laser printers.

Open PDF file after creation - This launches the PDF viewer so you can see the created document after printing.

Email PDF file after creation - Will automatically launch your email client's new message screen with the PDFfile

already attached.

5.15 Carbonless Printing

Carbonless Printing - This is a fantastic feature we've added to ClickBook. Now you can print carbonless forms with any
number of copies per form. ClickBook also handles the sub numbering on the form and can print the numbers as a header or
footer.

To activate Carbonless Printing follow these instructions.

N

P w

Print a file to ClickBook, and the ClickBook dialog appears.
On the menu bar select Layouts, and go to Modify Layout. The Modfiy Layout dialog appears.

Carbon #
Click on the w Carbon # box in the right hand corner of the screen to setup printing options.

Choose the number of Carbonless Copies |1 B Cabonless Copies you would like to print for each form.
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Exact text position from the top right corner. | i Change Iu:u:un...| [

Herizontal pos in % I—E E {+ Place the text right of the position i El Carbonless Copies  Carbon #

" Place the text on the pozition .
g (- | - . | apout Descrption:
Wertical pos in % |35 El " Place the text left of the position y. : -
T hiz lapout was designed o make a ”
cut book with 4 mini-pages to 1 sheet
Prezz the help button for examples. af paper. The mini-pages are punchead

out and then assembled into the o
(] Help Cancel

Help Cancel

Note: To set specific rules for Carbonless printing click on the Carbon # box.

Size: 8

¢ Click the Select Font button to change the font size, style, and type.

¢ Fill in the blank text box | with items you want to print on forms. Use
this numbering system:

e <> -these greater than, and less than signs enclose the number format.
e Use << to print a < #### - this prepends zeros to the number so <####> = 0001

e ™~ _this adds a number for each mini page in the carbon copy so <#### - > = 0001 - 001, 0001 - 002, 0001 -
003...

e date - adds a the date in the format of month day, year so <date> = September 21,2006
e time - adds the current time in the format of hours:minutes AM/PM so <time> = 10:48 AM
e job - adds the first job name listed so <job> = Microsoft Word - Readme File

e <d> - Day of month as digits with no leading zero

e <dd> - Day of month as digits with leading zero

e <ddd> - Day of week as a three-letter abbreviation

e <dddd> - Day of week as its full name

e <M> - Month as digits with no leading zero

e <MM> - Month as digits with leading zero

e <MMM> - Month as a three-letter abbreviation

¢ <MMMM> - Month as its full name
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e <y>- Year as last two digits, but with no leading zero

e <yy>- Year as last two digits, but with leading zero

e <yyy> - (should not happen) get 2 year strings y and yy

o <yyyy>- Year represented by full four digits

e <h> - Hours with no leading zero for single-digit hours; 12-hour clock.
e <hh> - Hours with leading zero for single-digit hours; 12-hour clock

e <H> - Hours with no leading zero for single-digit hours; 24-hour clock.
e <HH> - Hours with leading zero for single-digit hours; 24-hour clock.
e <m> - Minutes with no leading zero for single-digit minutes.

e <mm> - Minutes with leading zero for single-digit minutes.

e <s>- Seconds with no leading zero for single-digit seconds.

e <ss> - Seconds with leading zero for single-digit seconds.

e <t>- One character time-marker string, such as A or P.

e <tt>- Multicharacter time-marker string, such as AM or PM.

. Persistent Humber |-'I . . . . . .
e Persistent Number allows you to input a number to print on invoices. -1 will not print a

number. If you input 3283, the following invoices will print as 3284, 3285, and so forth. Each time you print to that specific
layout in ClickBook, it will keep track of the number for you.

e Exact Text Position gives you flexibility to place the invoice number, date, time, year, etc. on a specific place on the page.
For example, if you want the invoice number to print in the bottom center of the page, change the horizontal position to 50%
and select the radio button to Place the text on the postion. The default position is set to print in the bottom left hand corner
of the page.

Ewact text pazition fram the top right carner.

i . f* Place the text right of the position
Harizontal poz in & |5 El = i
(" Place the text an the pozition

Vertical pos in % |33 E (" Place the test left of the position

¢ Click OK to save changes, and Cancel to abort changes.

6.1 Types Of Layouts

This topic will be easy to understand if you read it while looking at ClickBook's Print Preview screen. Select various layouts in
turn, and compare each one.

What is a Layout?

A layout is a blueprint for a particular booklet, which is defined by a group of detailed settings that tell ClickBook how to
arrange the mini-pages on a sheet of paper. Some of the essential details are whether the paper orientation is portrait or
landscape, how many mini-pages are printed across and down on one sheet, whether to print single or double-sided, margin
sizes, and added space for binding.

Booklet Styles

Each layout also has a certain booklet style. This relates to how you intend to assemble and bind the booklet, and tells
ClickBook the order to print the mini-pages so they will end up in the right order in your finished booklet. There are six booklet
styles: Cut book, Folded book, French fold, Planner pages, Tiled, and Tri-fold. You can determine a layout's booklet style by
its name, the corresponding picture, and by looking at the Booklet Style in the Modify Layouts tab.
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11 3

Cut book Layouts are for methods of binding that require cutting between facing pages. Most of the cut book
layouts shipped with ClickBook are designed for paper that's pre-perforated for a custom appointment-book page.

4 1

Folded book Layouts are designed for folding between facing pages, and stapling. Examples include the
"Address book (folded)", "Wallet book (folded)", and "Side-by-side (folded)" layouts.

g 'z

11 French fold layouts are for making greeting cards from standard paper by folding the printed sheet in fourths.
The French fold style expects exactly four pages per sheet.

.

L1 ]

Planner page Layouts are designed for day planner paper that has holes on the left and right hand sides.

Posters are designed to expand one page onto multiple pages to make it larger. It requires some trimming and
taping, but you can make some impressive posters.

1]2 Tiled layouts are designed for multiple pages on a sheet but not cutting the sheet. The sheets that come out of
the printer are the final sheets. There are two sequences in which the mini-pages can be printed in a tiled layout. These
are controlled by the Binding Orientation options in the Modify Layouts dialog.

o Row-wise means page 2 prints to the right of page 1. For row-wise order, select the Standard binding orientation.

o Column-wise means pages 2 prints below of page 1. For column-wise order, select the Flip binding orientation.

>,8.1 Tri-fold Layouts are for printing single-sheet brochures or leaflets which are folded twice, making three panels
(mini-pages) on each side of the paper. The tri-fold style expects exactly six pages per brochure, since this style of
brochure is a single sheet of paper, folded. Tri-fold pagination places pages 5, 6, and 1 on one side, and pages 2, 3, and 4
on the other side. The front panel is thus page 1, and the reader opens up the brochure to see pages 2, 3, and 4 inside,
and then turns the sheet over to read pages 5 and 6.

6.2 Selecting A Layout

Answering the following series of questions will help you decide which layout you want.

¢ Is your document oriented as portrait or landscape? You should choose a layout that orients the mini-pages in the same
way. Look at the picture for each layout to determine its mini-page orientation. (ClickBook will warn you if you choose a
layout that doesn't match.

o What sort of booklet do you want to print?

e How large do you want your finished mini-pages to be? Mini-pages determine how many pages you want to include on a
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single sheet of paper, and how to fit them on the size of paper you're using. For examples look through the tiled or
booklet layouts. To choose a layout with an appropriate number of mini-pages, look at the print preview picture.

e What size do you want your fonts and graphics to appear? Small booklets usually require that you enlarge the fonts and
graphics, unless you choose to use No Scaling. If you choose No Scaling enlargement must be done in your application
program and then print the document to ClickBook again. If you want to enlarge the fonts in ClickBook refer to adjustable
Mini-pages.

To Select a Layout:

& =10] x|

JJ File [Layouts View Tools
E T Browsze through
+Page Categaries .-’-'-.I:u::ut
Set Default Lapouts. .. =
e : — . il =
Print Status

O
| Al Pages Received : 40 Pages

3o here to zee the
zettings for a Layout,

Layout wizard...
Modify Layout..

Browse through
Layauts

Temp

15ide-By-Side [foldedy

A 16 to a sheet, Landscape

Print Options

|HP Lassrlat i ~| _Print |
e ) F'agesl Lpply |

Enter page numbers and/or page ranges zeparated by D Double Sided
commas. Example: 1.3.5-12

Favvorit
# Copies EI1 avonies 20 to a sheet, Landscape

16 ta a sheet, Partrait

2 to a gheet, Landscape

2 to a gheet, Portrait

5
Print Jobs {} Franklin Covey Paper J:: 25 to a sheet, Portrait
Title | Pages | 4 — J
Mizrozaft Word - K., 40 Q Bookz - °- 4-1p Book, [folded] -
Thiz layout was designed ta make a folded boak with 8 min-pagesta 1 <
gheet of paper. It iz lwpically uzed on documents of 3 to 80 pages. ‘wWe —
recammend that vau use a 14 pt or larger font size to make your text ;I
Select a group of layouts. Ik Saver aff | |HUM | i

1. Print your document to ClickBook. For step-by-step instructions refer to Printing Your First Booklet.

2. Inthe Print Preview screen Browse through the Category drop down menu to quickly find layouts that match your
document type. For example, if you're printing a side-by-side folded booklet choose the Books category. Or if you're
printing your contact list to insert in your Day Planner, choose Personal Organizers, or Franklin Covey Paper.

3. Use the Layout drop down menu to browse through the available Layouts, and select one that matches your document.

4. To see the settings for a particular layout, select Layouts on the Menu bar and click on Modify Layouts.

6.3  Creating Or Modifying A Layout

To create a custom layout you will modify, rename, and save an existing one by following these steps:

1. Print your document to ClickBook. For step-by-step instructions refer to Printing Your First Booklet.

2. From the menu bar open layouts and select either Layout Wizard or Modify Layout. Please refer to either topic for more
details.
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Choose a layout that is similar to what you want.
Change any settings to create just the layout you want.
When you are finished making adjustments click the Save As button and save the new layout with a different name.

To modify an existing Layout proceed with the following steps:

1.
2.

3.

Print your document to ClickBook. For step-by-step instructions refer to Printing Your First Booklet.

From the menu bar open layouts and select either Layout Wizard or Modify Layout. Lets choose Modify Layout for this
particular exercise.

The Modify Layout dialog appears. Choose a Category and Layout from the drop down menus that are similar to what
you want.

Make desired changes by adjusting margins, scaling, mini-page margins, how many mini-pages you would like to appear
on a single sheet of paper and so forth.

Click Save As to save your changes to a new layout or Done to replace the old one. Click Abandon Changes to undo all
of the changes you haven't yet saved. The Layout will revert back to its original settings.

Examine your changed Layout in the Print Preview picture to see how your document is affected. If you are satisfied with
how the booklet looks, click Print. If you are not satisfied repeat steps 2 through 4 to further adjust the layout.

Note: Blue Squirrel recommends making a backup of your Layouts before altering them. You can do this by copying the
Layouts folder to a new name or to a backup disk. The default directory is C:\Program Files\Blue Squirrel\ClickBook\Layouts.
Then, if you ever need to revert to the default Layouts, just restore the original files.
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7.1  Printing Multiple Copies Sequentially

To print multiple copies of the same print job:

~Ix]

Print Status

| &l Pages Received : 4 Pages

Print Options Click Print
[HP Laserlet 54 ~] Print |

& &l  Pages I Apply |

Enter page numbers and/ar page ranges separated by
commas. Example: 1,3,5-12

Enter the amount
# Copies Eh of copies here

As usual, print from your application program to a ClickBook printer.

When ClickBook pops up, set the Num of copies option.

Click Print. ClickBook prints the first sides of all copies, with a single instruction sheet.

After the first sides of all copies have finished printing, put the whole printout stack back in the printer.
Click the Print Second Side button.

After the second sides of all copies have finished printing, separate the copies.

Cut, assemble, and bind each booklet individually.

NoghrwdhE

Note: If you want to print multiple identical booklets, follow the instructions above. Setting multiple copies within your
application program will not work correctly.

7.2  Previewing The Printout

The Print Preview lets you see how your document will look when printed with the selected layout. It is not accurate in every
detail, and your actual printout will look better than the preview. But the Print Preview enables you to see most features of the
printout, such as:

How mini-pages are positioned.

The relative sizes of margins and data.

How many sheets will print.

How many blank mini-pages will be printed at the end.

Zoom in on a mini-page by clicking on the mini-page or right-click and choose the zoom level up to 800%. Repeated clicks
will zoom in closer and closer until 800% is reached and then another click will take you to the full sheet view.

You can also zoom with the scroll wheel on your mouse. Paosition the cursor over the preview window and scroll the wheel to
zoom in and out.

Note:
e Use the bar beneath the picture to navigate to different sheets of the booklet:
e To go to the first or last sheet, click the arrow button at the left end or right end of the bar.
e To go to the next previous sheet, drag the slider button left or right. When the desired sheet number is shown, release
the mouse button.
e To go to the next or previous sheet click the bar on the left or right side of the slider, depending upon which way you
want to go.
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¢ Use the front and back buttons to see the other side of the currently displayed sheet.
¢ Use the Sheet selection to select a sample sheet to print for 100% accuracy.

7.3 Reinserting The Print Out Stack Before Printing The Second Side

The critical step of double-sided printing is correctly reinserting the first-side print out correctly into the printer so the second
side can be printed. Each detail of this process is important:

e When you are certain that all of the sheets from the first-side printout are done, remove the printout stack from the printer
without rearranging the pages. Make certain that if any other print jobs were sent to this printer, that you are holding only
your intended printout. If you're on a network and a printer prints an extra sheet (blank, or with network user id, for
example) between printouts, throw out that sheet.

e Turn the stack over if necessary to find the instruction sheet. Read the instruction sheet without lifting it off the stack.

¢ Reinsert the stack with the instruction sheet still on it.

o If your printer puts out an extraneous sheet before each print job ( e.g. printout separator sheets on network printer), place

a blank sheet on top after reinserting the stack. If the printer went offline when you reinserted the stack, put it back
online.

7.4  Return To ClickBook After Printing

With the Return to ClickBook after printing option is turned on, ClickBook will remain open after printing is complete allowing
you to:

Reprint a sheet or a range of sheets.

Save the booklet just printed as a .cb file.

Print the document as a different layout.

Modify the layout and print the document again.

You can turn this feature on temporarily for the current print job, or permanently for all future print jobs.

Follow these steps to enable this feature permanently:
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x|

PDF Security | POF Settings I Headers I Footers I W atermark z

Print Settings

¥ Print second side instructions.

[ Frint aszembly instuctions.,

[~ Print info sheet.

[T Frirt a Table af Contents page.

[T Force all booklet pages to have the same orientation,

[v Enable adjuztable Mini-pages.

Frogram Settingz I Paper. Borders

x|

Cancel Help

From the Toolbar choose the Options button

Press OK.

PoNE

Follow these steps to enable this feature temporarily:

|
O ptions

The Options dialog box appears, select the Program Settings Tab.
Mark the checkbox next to Return to ClickBook after printing.

g 5|

Print Status

- (o)

| Al Pages Received : 2 Pages

Print Options

Click, Frint bo
begin printing

Frinter : HF Lazer)et Sk

|HP Laser et i

i Al ™ Pages ||

Enter page numbers and/or page ranges separated by
commaz. Example: 1.3.5-12

# Copiez Eh

=] Elrint I
Apply |

Document : Microzoft %ord - Readme. rtf

rinting sheet 1 of 10

Cuickly mark, thiz
check box

[~ Retun to ClickBook after printing.
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1. Printfile(s) to ClickBook.

2. Click the Print button to send the Print Jobs to the printer.

3. While the booklet is printing ClickBook will quickly display a status screen, mark the check box to Return to ClickBook
after printing. (Be aware: this pops up and closes fast.)

4. ClickBook will re-open. This feature will remain on for the current print job.

7.5 Print A Range Of Sheets

Sometimes you want to print only a part of a booklet, for reasons such as:

Before printing the whole booklet, you want to print a sample sheet to see how it looks.

A sheet of paper jammed in your printer or came out creased.

After printing, you needed to make a small change that affected just a few pages of your document and did not change
the pagination.

Sheet #3 fell on the floor and the dog ate it...

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job. Here's how:

Select Sheet Selection,
and enter pages you
wizh ko print

Sheet #1 [frant]

| Fron Back | [FSheet Section
Selected Sheets

|1 E First Sheet % Front and Back

IWE Last Sheet  { Frant

[¥ Instuction Sheet Back

Categaries Layouts

Al j | ISide-By-Side [folded] ~

Thiz layout waz designed to make a folded boolk. with 4 mini-pages ﬂ
to 1 gheet of paper. It iz bpically uzed on documentz of 4 ta 30
pages. |t can be uzed to print software manualz, readme files, j

1. Click the Sheet Selection button.

2. Specify the range of sheets to be printed by setting First Sheet and Last Sheet. You must specify the first and last sheet
by number. Note: You can print one sheet or a continuous range, but not discontinuous sheets (like 1 and 4).

3. Choose the desired option for printing fronts and/or backs of the sheets. Also choose whether or not to print the
instruction sheet.

4. Click Print to begin printing.

Note: Refer to Previewing the Printout to learn how to navigate different parts of the booklet in the Print Preview Screen. Refer
to Return to ClickBook After Printing to prepare for the possibility of having to reprint a booklet before it finishes printing.
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7.6  Hand Fed Tray Printing

Hand Fed Tray printing was specifically designed to make it easier to print on LaserJet non duplexing printers, meaning a
printer that does not print on both sides of the paper automatically. This feature allows you to put the second side of the paper
into the Hand Fed tray for printing, instead of pulling out the main paper tray, reinserting the paper, and then reinserting the
paper tray. The Hand Fed tray option also makes it 100x easier to print on different paper sizes such as legal paper.

1. To use this feature you must first setup a Custom Printer with the Hand Fed Tray Paper Path. Go to
Custom Printer Setup and follow the instructions. Ensure that you check the box

[ Iwilluse the hand fed tray for the second side. i, the Custom Printer Setup wizard. Once you have setup a custom printer
proceed with the following instructions.
Print a file to ClickBook, and the program will open.
Choose your printer from the drop down.

4. Mark the check box "Use Hand Fed Tray" | UseHandFed Tray and press Print.

wn
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8.1  Setting Margins And Binding Space

Margins
Paper margins allow you to change the margins for a sheet of paper, and Mini-Page margins allow you to change the mini-
page margins for the current Layout.

Important:

¢ ClickBook's margins are in addition to the margins set in your application program.

¢ Unlike the application program's margins, which gets scaled down along with the contents of your document, ClickBook's
margins print at the exact size specified.

To change either margins follow these steps:

1. From the Menu bar select Layouts and click on Modify layouts.

2. Under the Margin section alter the settings to your liking by using up and down arrows on the number boxes. To make a
big increase or decrease, hold the mouse button down until the desired value is reached.

3. View the results by watching the Layout picture, which redraws automatically to show the margin changes. The margins,
including the Binding margin are shown in blue.

4. When you are finished, press Done.

Note: Usually you should set your application program's page margins or ClickBook's Top/Bottom and Left/Right Mini-page
Margins. If you choose to set ClickBook's we recommend that you first print a part of your booklet and measure the exact of
margin you want to add. Then print the entire document with the Mini-page margins set correctly.

Note: Set the Paper Margins to match the cut-away or pre-perforated tear-off areas around the edges of some custom papers.

Bindin

The Bimﬂng margin is extra space only on the side where the book will be bound. You can adjust the following:
o Printer Paper Size - Select the size of paper you want to use.
¢ Binding Edge - Choose how you want the binding edge.
¢ Print Sides - Select to print on one side or both sides of paper.

Proceed with the following steps to change Binding.

1. From the Menu bar select Layouts and click on Modify layouts.
2. Under the Binding section alter the settings to your liking.

3. When you are finished, press Done.

8.2  Printing Sub-booklets To Bind Together

Sub-booklets or commonly referred to as Signatures are printed pages that are folded and then trimmed, and stacked with
other sub-booklets or signatures to make a book. An A 6 page signature would be the same ClickBook's 24-page sub-booklet
when using the side-by-side folded layout. 6 pieces of paper when folded makes a 24-minipage book.

Rather than folding a whole booklet together, you may wish to print and fold sub-booklets or signatures separately, and then
bind them together.
Reasons for using Signatures or sub-booklets include:

e To avoid shingling or margin creep that otherwise occurs with thick folded booklets.

e To meet the needs of special binding methods.

e To separate individual documents from a mail-merge print stream.

To enable ClickBook's Sub-booklet feature follow these steps:

1. From the Menu bar select Layouts and click on Modify layouts.
2. The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to Sub-booklets.
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3.

4

Use the up and down arrows next to Pages-per to set the amount of pages each sub-booklet will contain.
. When you are finished press Done.

8.3  Printing On Legal Size Paper

If
b

your printer tray allows you to input and print legal size paper please proceed with the instructions below. If your printer must
e handfed with legal size paper to print please ensure you follow the instructions to setup a custom printer to use the hand

fed tray. See Hand Fed Tray Printing.

1. Once you have setup your printer print the file from its application to ClickBook.
2. Choose Books from the Layout drop down, and Side-By-Side Legal (folded) from the Layouts drop down.
Categaries Lapouts
‘ Q Books j ‘ Side-By-Side - Legal [folded] j
3. Mark the check box Use Hand Fed Tray. | UseHand Fed Tray
4. Select the printer, and press Print.
8.4 Repeat

The effect of Repeat depends on the current Layout. Repeat can be used to print more copies when there aren't enough mini-

p

ages to fill the sheet. Repeat can also be used, alternatively, to avoid the step of assembling multiple booklets. ClickBook

contains two Layouts with Repeat turned on, they are the Business card layouts and Greeting card (heavy stock repeat)
layouts.

To activate Repeat proceed as follows:

1.
2.
3.

From the Menu bar select Layouts and click on Modify layouts.
The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to Repeat.
When you are finished press Done.

Aspect Ratio - The ratio of width to height. If the aspect ratio changes then photographs can appear stretched or
squeezed.

Banner - A Poster that is significantly wider than it is tall. Constructed by taping multiple pages together, it usually
announces happy events like birthdays, homecomings, and graduations.

Binding Edge - A standard binding edge is for right/left. A flip binding edge is for folding top/bottom.

Crop - Cropping chops off portions of a document.

Duplex - Printing on both sides of the paper. Many printers include a duplexer that allows the printer to print on both sides
of the paper without human intervention. ClickBook supports printers with duplexers.

Header - Text that will be printed at the top of every mini-page. It may include page numbers, job name, date, etc.
Footer - Text that will be printed at the bottom of every mini-page. It may include page nhumbers, job name, date, etc.
Forms - Electronic forms and letterhead for printing with different layouts

Landscape - A paper orientation where the words on the page are going across the long edge of the paper. See Portrait.
Layout - A specific configuration of ClickBook that turns a print out in to a poster, booklet, card, brochure, etc.
Mini-Pages - The area on a piece of paper that the source document pages will be placed. Example: One piece of paper
would have 4 mini-pages for a folded booklet. Two mini-pages on each side of the piece of paper.

One-to-One - A Scaling option that keeps the shape. This scaling option is better for photos.

Overlap - When printing Banners or Posters, some extra is printed on each page to allow easy alignment of the pages
when assembling the poster or banner.

Portrait - A paper orientation where the words on the page are going across the short edge of the paper. See Landscape.
Poster - A large format print out which is constructed by taping pages together.

Poster Wizard - A quick easy way to create a custom poster. For more fine control, use Modify Layout.

Sample Document - A document that works with a set of layouts. The many samples included with ClickBook show how
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the document works with ClickBook to create a print out.

e Scaling - Stretching or shrinking a document to fit an area on a piece of paper. One-to-one scaling will keep the aspect
ratio.

e Stretch-to-Fit - Stretches the source document to fit the new area. If the area is not the same shape, the document may
need to be stretched more in one direction. This is usually fine for text, but leads to photos that may look stretched or
squeezed.

e Sub-booklets - Breaking a full booklet print job into smaller booklets that can be individually folded, stacked and bound.

e VIP Key - A key that removes the trial stamps and fully activates the software.

e Watermark - A graphic that is printed on every mini-page. This can be used for document authenticity, or to print a
company logo.

Technical Support
If you are having difficulties using ClickBook, please check the following:

The problem may be with the printer. See whether the problem still occurs when you (A) print without ClickBook, or (B) print
on a different printer. If the problem still occurs in case A, or goes away in case B, the problem is with your printer or its driver.
The first possible solution is to get a newer printer driver. If no newer driver is available, or using the latest one does not solve
the problem, contact the manufacturer or vendor of your printer.

Frequently, problems observed in applications actually are based in the operating system. Does your problem occur in other
applications as well? Do any other symptoms suggest that the problem may be in Windows? If so, you need Windows
technical support.

Read the accompanying ReadMe.rtf file for any late breaking information about ClickBook, and using ClickBook with specific

software or hardware. You can access the ReadMe file by going to your Windows Start Menu. Then Select Programs, Blue
Squirrel, and ClickBook ReadMe. Please note this is the default location, your ReadMe file may be stored elsewhere.

Visit Our Web Site

If you cannot find the information you need in any of the preceding sources, contact us at our Web site. Please refer to
ClickBook's support and FAQs for frequently asked questions. http://www.bluesquirrel.com/support/

Contact Us
If you would like to speak with a representative regarding a non-technical question please call Customer Service at:

THE BLUE SQUIRREL END USER LICENSE AGREEMENT REDISTRIBUTION NOT PERMITTED

GRANT. Subject to payment of applicable license fees, Blue Squirrel grants you a non-exclusive license to use the Software and accompanying documentation ("Documentation”) in the
manner described below under "Scope of Grant."

SCOPE OF GRANT
You may:
e use the Software on any single computer;
« use the Software on a network, provided that each person accessing the Software through the network must have a copy licensed to that person;
e use the Software on a second computer so long as only one copy is used at a time;
« copy the Software for archival purposes, provided any copy must contain all of the original Software's proprietary notices; or
« if you have purchased licenses for a 10 Pack or a 50 Pack, make up to 10 or 50 copies, respectively, of the Software (but not the documentation), provided any copy must contain
all of the original Software's proprietary notices. The number of copies is the total number of copies that may be made for all platforms. Additional copies of Documentation may
be purchased.

You may not:
e permit other individuals to use the Software except under the terms listed above;
e permit concurrent use of the Software;
« modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable laws specifically prohibit such restriction), or create derivative works based on the
Software;
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e copy the Software other than as specified above;
e rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or
e remove any proprietary notices or labels on the Software.

LIMITED WARRANTY.

Blue Squirrel warrants that for a period of ninety (90) days from the date of acquisition, the Software, if operated as directed, will substantially achieve the functionality described in the
Documentation. Blue Squirrel does not warrant, however, that your use of the Software will be uninterrupted or that the operation of the Software will be error-free or secure. In addition,
you must determine that the Software sufficiently meets your requirements. Blue Squirrel also warrants that the media containing the Software, if provided by Blue Squirrel, is free from
defects in material and workmanship and will so remain for ninety (90) days from the date you acquired the Software. Blue Squirrel's sole liability for any breach of this warranty shall be, in
Blue Squirrel's sole discretion; (i) to replace your defective media; or (ii) to advise you how to achieve substantially the same functionality with the Software as described in the
Documentation through a procedure different from that set forth in the Documentation; or (iii) if the above remedies are impracticable, to refund the license fee paid for the Software.
Repaired, corrected, or replaced Software and Documentation shall be covered by this limited warranty for the period remaining under the warranty that covered the original Software, or if
longer, for thirty (30) days after the date (a) of shipment to you of the repaired or replaced Software, or (b) Blue Squirrel advised you how to operate the Software so as to achieve the
functionality described in the Documentation. Only if you inform Blue Squirrel of your problem with the Software during the applicable warranty period and provide evidence of the date
you purchased a license to the Software will Blue Squirrel be obligated to honor this warranty. Blue Squirrel will use reasonable commercial efforts to repair, replace, advise or, refund
pursuant to the foregoing warranty within 30 days of being so notified. IF THE SOFTWARE IS INCLUDED AS PART OF A LARGER BUNDLE, SOME OF THESE REMEDIES MAY
NOT BE AVAILABLE TO YOU.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY BLUE SQUIRREL. BLUE SQUIRREL MAKES NO OTHER EXPRESS WARRANTY AND NO
WARRANTY OF NONINFRINGEMENT OF THIRD PARTIES' RIGHTS. THE DURATION OF IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION, WARRANTIES OF
MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED TO THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. NO BLUE SQUIRREL DEALER, AGENT, OR EMPLOYEE IS
AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. If any modifications are made to the Software by you during the warranty
period; if the media is subjected to accident, abuse, or improper use; or if you violate the terms of this Agreement, then this warranty shall immediately be terminated. This warranty shall
not apply if the Software is used on or in conjunction with hardware or software other than the unmodified version of hardware and software with which the software was designed to be
used as described in the Documentation.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION.

TITLE. Title, ownership rights, and intellectual property rights in the Software shall remain in Blue Squirrel and/or its suppliers. The Software is protected by the copyright laws and
treaties. Title and related rights in the content accessed through the Software is the property of the applicable content owner and may be protected by applicable law. This License gives
you no rights to such content.

TERMINATION. The license will terminate automatically if you fail to comply with the limitations described herein. On termination, you must destroy all copies of the Software and
Documentation.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE SHALL BLUE SQUIRREL OR ITS
SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY
CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL
OTHER COMMERCIAL DAMAGES OR LOSSES. IN NO EVENT WILL BLUE SQUIRREL BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT BLUE SQUIRREL
RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF BLUE SQUIRREL SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR
ANY CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE
LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

MISCELLANEOUS. If the copy of the Software you received was accompanied by a printed or other form of "hard copy" End User License Agreement whose terms vary from this
Agreement, then the hard copy End User License Agreement governs your use of the Software. This Agreement represents the complete agreement concerning this license and may be
amended only by a writing executed by both parties. THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR ASSENT
TO THE TERMS SET FORTH HEREIN, AND NOT THOSE IN YOUR PURCHASE ORDER. If any provision of this Agreement is held to be unenforceable, such provision shall be
reformed only to the extent necessary to make it enforceable. This Agreement shall be governed by Texas law (except for conflict of law provisions). The application of the United
Nations Convention of Contracts for the International Sale of Goods is expressly excluded.

U.S. GOVERNMENT RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions set forth in subparagraphs (a) through (d) of the Commercial
Computer-Restricted Rights clause at FAR 52.227-19 when applicable, or in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013, or at 252.211-7015, and in similar clauses in the NASA FAR Supplement. Contractor/manufacturer is Blue Squirrel, 686 E. 8400 South Sandy, UT 84070.
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